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Building Your EBook 

Word is a great tool to use because it's extremely easy to format. EBG 24/7 suggests writing your 

book in Microsoft Word or converting an existing source file into Word (.doc or .docx) format 

before continuing. Here are some important tips to ensure an excellent eBook conversion and 

layout.  

This Guide is written for non-technical readers. We present simple, step-by-step instructions to 

help you produce a professionally formatted and quality EBook.  

 

Before you start   

 

Back 

 

http://www.ebg247.com/authors


 

 

Make a Back Up: The first step in this process is to make a backup. Keep your original file 

separate from your revised file in case you run into formatting issues.  This way you will have 

the original work saved in a safe place. 

 

Microsoft Word’s Show/Hide Feature: It reveals your hidden formatting BEFORE you start 

formatting. The show/hide icon looks like ¶ and is located on the “Home” tab in the “Paragraph” 

section. This icon when selected shows all of the formatting in document including the paragraph 

returns, extra spaces, tabs, field codes or other special formatting.  

 

If you use Word 2000 or 2003, you can usually find it in Tools: Options: View and then under 

Formatting Marks click All.  

 

With this option turned on it will help you remove all of the unwanted Microsoft Word 

formatting such as tabs, hard returns, and unwanted margin settings. 

 

Turn off Word's AutoCorrect: We would like you to turn of Auto correct so that you can 

simplify all your formatting and keep it simple so that E-Readers can display your work in clean 

and professional looking screen display.  

 

This option can be found under the Tools tab in older versions of Word or under the Microsoft 

office button in the top left. Click on Word Options then Proofing. You will see the autocorrect 

dialog box at the top left of the pop up menu. Here you can disable unwanted options. 

 

 

File Format: Save your source file as a .doc or .docx format, and be sure to save your work as 

you make changes to ensure all changes are updated. EBG 24/7 only accepts Microsoft Word 

documents to be converted into an eBook. 

Page Numbers: Do not add page numbers in your Microsoft Word Document. Page numbers are 

not relevant to EBook readers because each device has different screen sizes and formatting 

parameters, larger screen devices will have fewer pages. 

Formatting Your Text 

 

Text: Use indentations, bold characters, italics and headings, as you see fit. These formatting 

options will not be lost in the file conversion. Special characters such as, bullet points, custom 

fonts, headers, and footers do not convert well, we recommend that you avoid those.  

Managing and Modifying Paragraph Styles, Fonts 

Start with the paragraph styles set to “Normal”:  The majority of your book will be the body 

text, i.e. the words and paragraphs that make up your body content, we start by setting the entire 

book to the Normal paragraph style. This saves you time. Remember keep it simple, you can 



 

 

format your headings and other sections after you have defined your styles. The key to this step 

is to remain consistent with the formatting throughout the document. This keeps a clean look.  

 

Modifying Paragraphs:  At the beginning of a paragraph in your body text, you can use first 

line indents or you can use the block paragraph method. Don’t mix and match both.  

If you use Word 2000 or 2003, click “Modify”: “Format”: “Paragraph”.  If you are using Word 

2007 or newer click on the “Home” tab and then the “Change Styles’ icon on the far right of the 

top navigation bar. Next right click on your style and choose modify. Click on the format button 

in the lower left hand corner and choose paragraph.  

 

Here you can set your First line indents under the “Special” dropdown menu. In order to 

optimize the space for your first line indent you should click on the dropdown menu next to the 

label “By” and enter .25 or .3 inch. Don’t use indents greater than .5 inch. After that, make sure 

the “Spacing” section below doesn’t define a “Before” or “After” space. Both should be set to 

0pt,  

 

If you want to use the Block Paragraph method follow the steps above to get to the paragraph 

style editing screen. To use Block Paragraph methods simply edit the spacing section. There is 

no industry standard for this so feel free to pick whichever format works best for you. 

 

Fonts: Use standard fonts like “Helvetica” or “Times New Roman” because not all readers will 

be able to support your custom font. Font sizing is important, to best display your work use 12pt 

for the body and 14pt for the book title on the cover page. If you must use different font sizes, 

minimize the range from body size to headline size. There may also be issues with resizing it to 

fit the screen for mobile devices if you use font sizes larger then 18pt. Font color is also 

important, you will need to set your font color to “Automatic”. This will enable the night mode 

function to work correctly on EBook readers. If you would like to keep font size consistent 

throughout your book, format the chapter headings with a separate style.  Microsoft word gives 

you a few preset custom style Headings to choose from. 

 

Custom Styles: To create a different style than normal, using Word 2000 or 2003, click Modify: 

Format: “styles”. If you are using Word 2007 or newer click on the home tab and then the 

change styles icon. In the bottom left far bottom row of icons click on the “New Style” icon this 

will bring up the “create new style for formatting” dialog box. Here you can create new custom 

styles. Don’t get too carried away with custom styles, less is better. 

 

Paragraph Marks: if your word document shows other paragraph marks other than ¶ this will 

cause issues in the file conversion. If you see  in the front of your sentence or paragraph simply 

highlight the sentence or paragraph. Right click and select paragraph. Under the line and page 

breaks tab uncheck keep with next and keep lines together. If left checked this will change the 

style and size of the font to become large, bold text. To make sure your file conversion goes as 

smooth as possible make sure those options are unchecked. 

 

Page Breaks:  



 

 

Enter a page break at the end of every chapter to prevent the text from running together. This 

will ensure proper spacing and automatically bring the next chapter to the beginning of the next 

page. Do not use multiple consecutive paragraph returns to force page breaks or to arrange text 

on the screen, because they’ll create a poor reading experience by creating blank pages or 

unformatted gaps on the screen of small mobile devices. Instead you should use the “Page 

Break” option to create a new page. Microsoft word will allow you to add page breaks in the 

Page layout tab “Breaks”. 

 

Formatting Images 

 

 

Image Placement: Images should be inserted as JPEG (or .jpeg) format by using the “Insert” 

“Picture” “As File” option. If your book has a lot of images, be sure to optimize the file size by 

not saving them in “maximum quality”.  An optimized image should fall in the range of quality 

from Medium – 30%  to High – 60% compression.  

 

Resizing images: It’s best to resize your images before you import them into Word. There is a 

number of free image editing software out there if you need to resize your images. Images work 

best if you keep their dimensions small. If your current image runs more than half your full page 

width, it may not display properly on smaller screens. Keep embedded images to widths of 

around 500 pixels or less. 

 

Floating images: Do not use floating images (if you can move the image and drag it around then 

it is set to float).   EBG 24/7 does not support floating images because the images may appear in 

unpredictable places after the file conversion. To anchor floating images, right mouse click on 

the image, then click “Format Picture”, then click “Layout”, then click “In Line With Text”, 

then click “Save”.  Finally click Word’s “Center” button or create a custom style for centered 

text, and then apply that style to your image. 

 

Images with embedded text: Avoid using text overtop an image. It’s best to remove text and 

place it above or below the image. This ensures that readers can resize the text to meet their 

reading preferences, and screen display. 

 

Book Cover 

 Add your book cover to the first page of your document. This will ensure that your cover shows 

up on readers and tablets.  

 

Book Cover Image: We require your book cover to be a ratio of 1:1.5 (6:9) image. The pixel 

sizes are 1600 wide x 2400 tall. The resolution can be from 72 dpi to 300 dpi (dots per inch). 

The cover image orientation should be “Portrait”.   We do not except square images.  

 



 

 

 

Your EBook cover is your first selling point. You should take some time to design your cover in 

order to give your book an elegant and professional touch. There are plenty of places on the web 

that will design your book cover for a reasonable price. A successful eBook has an interesting 

cover, make sure the cover backs up the content of the book. 

 

Book covers cannot contain nudity, a set price, or a web address as well as advertisements of 

items not already included in the book. The cover cannot be grainy, blurry or pixelated, 

remember the cover is your chance to make a good first impression. 

 

Headers and Footers: EBG 24/7 does not support headers and footers automatically formatted 

by Microsoft Word. They don’t translate through the file conversion process and will not display. 

 

Tables: EBG 247 does not recommend using embedded tables due to the lack of support from 

older eBook readers. 

Linking Rules – Please limit your hyperlinks to only your EBG 24/7 author page, or your 

personal website or blog. Too many external links are distracting to the readers.  

 

Creating Front Matter 

Front matter is the first section of a book and is usually the shortest. It may include a Title Page, 

Copyright Page, Preface, Dedication, and Prologue. It can be as simple as a single title page. 

 

Title & Copyright Page: This page is where you identify yourself as the author and claim 

copyright ownership of your work. The title page should be centered with the title on top and 

Author Name underneath, like in the formatted example below.  

 

War and Peace 
By Leo Tolstoy 

 
Copyright 2014 “Authors Name” 

-Insert Page Break Here- 

 

Be sure to insert a “Page Break”. To insert a page break in Word, visit the page layout tab. 

Dedication: If you have a personalized Dedication, it should follow the Copyright page. Insert a 

page break after the Dedication. 

 

Preface: If you have a Preface or introduction written from the author, it should follow the 

Dedication. Be sure to insert a page break.  

 

Prologue: If your book includes a Prologue or the opening of your story, it should follow the 



 

 

Preface; this should be located immediately before the first chapter. Insert a page break before 

the beginning first chapter. 

 

ISBN 

EBG 24/7 will provide you with one ISBN number per converted file. EPUB file formats require 

their own ISBN as well as MOBI file formats require their own ISBN. We offer two Author 

Packages that consist of one ISBN number for an EPUB file conversion or two ISBN numbers 

which consists of one for each file conversion. The more file formats the author has the wider 

range of viewing devices their book can be viewed on. 

Our EBook conversion software will add the ISBN number to the proper file format. As a 

courtesy to you we will also register your ISBN to that particular file format. If you have your 

own ISBN’s there is also a package for you. Our third package is for authors who have already 

published their book or have an existing ISBN.  

   

Creating an Active Table of Contents 

Start with making a list of the sections you want to be displayed in your table of contents. 

Table of contents 

Chapter One 

Chapter Two 

Chapter Three 

 

Nothing is linked yet just typed out. Next create your bookmarks 

 

Bookmarks: The first thing you want to do is create a bookmark.  Select “Table of Contents” 

and then go to your ‘Insert’ tab.  Click on ‘Bookmark’ top tool bar. Give your bookmark a 

custom name, and then click “Add”. The bookmark option does not support spaces in the names 

so you have to use “-” or “_” to separate words. 

 

Next, scroll to the Chapter One heading in your book.   Highlight the text and go to your “Insert” 

tab.  Click on “Bookmark” in the top tool bar. Give your bookmark a custom name, and then 

click “Add”. Continue through your document bookmarking every heading in your Table of 

Contents. Remember to name it as the same instance as your Table of Contents List you made in 

the first step. 

 

Creating the links: Now it’s time to hyperlink the table of contents to the chapter.  Select 

“Chapter 1” in the table of contents, go to the insert tab and click on “Hyperlink”. On the left, 

you want to “Link to:”  “Place in this Document”.  That will bring up your bookmarks.  Select 



 

 

“Chapter  One”(or whatever you call your Chapter 1) and click “OK”.  That will make your blue 

hyperlink Chapter 1 in the table of contents. 

There you go, you now have a Active Table of Contents.  

Creating Back Matter 

Back matter consists of the last pages in your book which provides additional information the 

reader should know about, such as Bibliographies, Appendices, Notes or Glossaries. Consider 

adding a personal message, people may want to read more of your material. This is an 

opportunity to connect with the reader. Thank them for reading or add a list of other eBooks you 

have written. Remember links to other websites where your book can be purchased will not be 

allowed and will be removed prior to your book being published on our site. 

 

 

Wrapping it up 

After you have followed theses quick and easy formatting steps, be sure to save your source file 

as a .doc or .docx format in Microsoft Word. Visit our Steps to Getting Published page for more 

information on what you will need before you upload your book. 

 

How to Upload Your Book 

Before you start uploading your book, please read the Authors agreement and download the PDF 

document from the footer. This document contains all of the information that you need for your 

rights as an author on EBG 24/7. 

After your have read the agreement and accepted the terms, 

1. Fill out the your first and last name 

2. If you have a preferred Pen Name enter it here 

3. Enter your e-mail address 

4. Check the box to choose which name you prefer to be displayed on the book display 

(legal name or pen name) 

5. Select if you are 18 or over. If you are under 18 we will require information from 

your parent or guardian  

6. Enter the name (s) of any co-authors if you have multiple authors. List the primary 

author first and separate additional names with comas 

7. Fill out the Payee’s address information. This information is to be kept on file to pay 

royalties to the Author. 



 

 

8. Enter your work’s title as you would like it to be displayed on the site 

9. Choose the category that best describes the genre of your work  

10. Upload your display cover. See book cover guidelines 

11. Upload your work source file. EBG 24/7 only accepts Microsoft Word documents 

with the extensions .doc and .dox 

12. Enter a brief description or Synopsis no longer than 150 characters 

13. Enter the key words that will be associated with your work to be used in search 

queries  

14. Choose how you would like to revive your royalty payments. EBG 24/7 offers PayPal 

electronic funds transfer or paper check. For more information see Royalties 

15. If you choose PayPal Personal Account enter the email address linked to your PayPal 

account 

16. Enter the selling price of your work 

17. Double check all your form entries 

18. Click “add to cart” 

After you click the “add to cart” button at the bottom of the “Author’s Packages” submission 

form, your browser will pause for several seconds as your files upload. If you have a slower 

internet connection it may take longer. While the files are Up Loading please don’t click on the 

reload or refresh button, this may cause double submissions. 

 

If you click the “add to cart” button and it bounces you back to the previous page, carefully read 

the error messages, they will be displayed in the red box above the form. If you’re having 

problems uploading your information please contact us at customersupport@ebg247.com. 

 

Continue to your shopping cart and process your payment. 

 

 

 

Pricing your Book 

Determining the price of your work is crucial to the success of your ebook. If you charge a low 

price then some people will consider it to be of little value, and they will likely be hesitant to 

invest in your ebook. If you ask for a very high price, then again you may discover that very few 

people want to order it. EBG 24/7 suggests a selling price from $2.99 - $9.99 depending on the 

inferred value of the work.  

 

 

Royalties 

Payment of royalties is dependent on the Author’s compliance with this entire Agreement. Work 

must comply with all copyright regulations. If all proper rules are met then royalty payments will 

be distributed as follows: 

mailto:customersupport@ebg247.com


 

 

EBG 24/7 pays the Author 70% of the net profits received from the sales or licensing of their 

Work. Net proceeds shall be defined as sales price paid less payment processing fees, retailer 

discounts, and costs due to erroneous or fraudulent transactions, credit card chargebacks and 

their associated fees. Processing fees are estimated and stated in the submission form for your 

Work.  

 

Author’s earnings will be paid within 30 days of the end of each calendar quarter.  To qualify for 

payment earnings must be over $25.00 for authors paid via PayPal, earnings must be over $75.00 

for authors who wish to be paid by paper check.  An additional processing fee of $5.00 will be 

charged to authors paid by paper check.   

 

The quarters are Q1 (Jan-Feb-March), Q2 (April-May-June), Q3 (July-August-Sept.) Q4 (Oct. 

Nov. Dec.).  EBG24/7 processes and issues royalty payments within 30 days after the end of 

each quarter.  If accrued earnings are less than the minimum requirement for royalty payments, 

funds will remain in the Authors account until the end of the quarter in which the minimum 

balance is met.   If royalty payments are interrupted due to outdated information from the 

Author, royalties will be held until the end of the quarter in which the information has been 

updated.  Tax reports will be available at the end of the year. 

 

Authors may designate a payee for their account.  Payee may be parent or guardian of a minor, 

representative of co-authors or agent.  Payee needs to be designated on the submission form.  

Any changes to the Payee or their contact information must to be submitted to EBG24/7 as soon 

as possible.   

 

EGB247 would like to take this opportunity to thank you for the submission of your book to our 

site.  We are EBG247 are committed to helping each author make to most of their book selling 

experience with us.  If you have any questions or if we may be of additional help to you please 

let us know. 

 

 

 


